G etting Sta rted w ith M a pObjects Vers ion2.1
inDelphi5.0
In this introductory document you'll use MapObjects version 2.1 and Borland © Delphi 5.0 to build an
application that uses maps. Along the way you will learn how to . .
• Display a map with multiple layers
• Control panning and zooming
• Create a toolbar control
• Display map layers based on scale
• Perform spatial and logical queries
• Draw simple graphics on the map
• Display features with thematic renderers
• Dynamically display real-time data with an event tracking layer
• Programmatically add data to a map
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Loa ding M a pObjects
Start Delphi and choose Import ActiveX Control from the Component menu. Find the ESRI
MapObjects 2.1 reference in the list of available controls. If MapObjects 2.1 is not listed, click
Add to include the MapObjects 2.1 reference in the list. Finally, click Install to rebuild the
omponent library.

Notice that a new tool appears in the list of ActiveX icons on the toolbar of the component palette. This
new tool is the MapObjects 2.1 map control.
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G etting M a pObjects Help
The map control is one of the 48 objects that make up MapObjects 2.1. To find out about the
various objects, open the MapObjects online help and select Objects in the table of contents.

The help system provides help for every object, property, method, event, and constant in
MapObjects 2.1.
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Adding a M a p
Add the M a p Control to the Form
1.
2.

Double-click the map control in the ActiveX palette to add a new map to the form.
Resize the map to fill the form.

Add Da ta to the M a p
You can specify the data that is displayed in the map by setting properties in the map control's
property sheet.
1.

Right-click the mouse on the map to display the context menu.

2.

Choose Properties to display the property sheet.

3.

Click Add and locate the folder where the sample data is stored for the USA.

4.
5.

Choose the States.shp file and then click Open.
Add the file USHigh.shp in the same manner.
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Set Properties for the La yers
1.

With the MapObjects Map Control Properties window still open, choose the States layer
in the Layers list and then click Properties.

2.

Click the Color button to select a color for the States layer.

3.
4.

Click OK to close the dialog.
Select a color for the USHigh layer in the same manner.

5.

Click OK to close the property window.

Sa ve the Project
1.
2.

Click the File menu and then select Save All.
In the File Name box for the unit, type “StarterMap.pas.”

3.
4.

Click Save.
In the second Save As dialog for the project, type “Starter_Map.dpr” in the File Name box.

5.

Click Save.

Tes t you r a pplica tion
1.
2.

Click the Run button in the Delphi toolbar.
To stop running your application and return to design mode, close the form.
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Adding Pa na nd Zoom Controls
At this point, your application can display the map at its full extent. In this section you will add
some simple pan and zoom controls that will be activated in response to mouse clicks inside the
map. You will write some code that will be executed in response to the MouseDown event on the
map.

Res pond to the M ou s eDow nEvent
1.
2.

Select the map control then select the Events page in the Delphi Object Inspector. Doubleclick the OnMouseDown event to add an event handler.
Add code to the MouseDown procedure for Map1:
procedure TForm1.Map1MouseDown(Sender: TObject; Button: TMouseButton;
Shift: TShiftState; X, Y: Integer);
begin
Map1.Extent := Map1.TrackRectangle;
end;

TrackRectangle is a method that applies to a map. It tracks the movement of the mouse while the
user presses the mouse button, rubber-banding a rectangle at the same time. When the user
releases the mouse button, the TrackRectangle method returns a Rectangle object which the
application assigns into the Extent property of the map, causing the map to be redrawn with a
new map extent.

Tes t you r cha ng e
1.
2.
3.

Click the Run button in the Delphi toolbar.
Click and drag the left mouse button on the map to rubber-band a rectangle
Release the mouse button and notice that the map is redrawn at the location you specified.
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Close the form to return to design mode.

Add Pa nning
1.
2.

Double-click the OnMouseDown event in the Object Inspector to display the code window
again.
Change the code for the MouseDown procedure for Map1.
procedure TForm1.Map1MouseDown(Sender: TObject; Button: TMouseButton;
Shift: TShiftState; X, Y: Integer);
begin
if (Button = mbLeft) then
Map1.Extent := Map1.TrackRectangle
else
Map1.Pan;
end;

Use the left mouse button to zoom in to the map; use the right mouse button to invoke the Pan
method.

Add a Fu llExtent Bu tton
Your application now supports panning and zooming, but once the user has zoomed into the
map, there is no way to get back to the full extent again. In this section you will add a button to
the form which resets the map’s extent to its full extent.
1.
2.

Click the Button tool on the Standard controls page in the control palette, then click the form
to add a button.
Move the button to the upper right of the form.

3.

With the button selected, click the Properties page in the Object Inspector window.

4.
5.

Click in the Caption box and type “Full Extent”..
Resize the map control so that it is not obscured by the button.
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6.
7.
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Double-click Full Extent to display the code window.
Add code for the Click event of the button.
procedure TForm1.Button1Click(Sender: TObject);
begin
Map1.Extent := Map1.FullExtent;
end;

The FullExtent property of the map returns a Rectangle which defines the bounding box of all the
layers of the map.

Tes t You r Cha ng e
1.
2.
3.
4.
5.

Click the Run button in the Delphi toolbar.
Click and drag the left mouse button on the map to rubber-band a rectangle.
Release the mouse button to reset the map extent.
Click the map with the right mouse button and drag to pan the map.
Release the mouse button to redraw the map.

6.

Click Full Extent to redraw the map at the full extent.

Sa ve the Project
1.
2.

Close the form to return to design mode.
Click the Save All button in the Delphi toolbar to save your changes.

Adding a Toolba r
Your application's pan and zoom capabilities are somewhat hidden from the user. In this section
you will create a toolbar with pan and zoom buttons.

Adding a Pa nel
Panels are a convenient way to group controls on a form and will be used to implement the
toolbar.
1.
2.

Delete the Full Extent button from the form.
Select the Panel control from the Standard controls page and place a panel at the top of the
form.

3.

Set the Caption property of the panel to blank and set the Align property to alTop. Set the
BevelOuter property to bvNone. Set the Name of the panel to “MapToolbar.”
Resize the map so that it is not obscured by the panel.

4.
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Adding Bu ttons to the Pa nelControl
1.

Select the MapToolbar panel.

2.

Click the SpeedButton control on the Additional palette page.

3.

Click the MapToolbar panel to place a button on the panel.

4.

Set the Name property for the new button to “ZoomBtn.”

5.

Double-click the Glyph property in the Object Inspector to open the property editor for
glyphs.

6.

Use the Load button to select Zoom.bmp as the picture for the zoom button.

7.

Add a PanBtn (Pan.bmp), QueryBtn (Bex.bmp), AddEventBtn (Pennant.bmp) and
FullExtentBtn(Globe.bmp) buttons in the same manner.
Since the first four buttons will work together, with one selected at a time, select the first
four buttons and set their GroupIndex property to “1.”

8.
8.

Set the Down property for the ZoomBtn to “True” to make it the selected tool by default.

9

G etting Sta rted w ith M a pObjects 2.1 inDelphi5.0

10

Cha ng e the M ou s eDow nEvent
1.
2.

Select the map control on the form and double-click the OnMouseDown event in the
Property Inspector to display the code window.
Modify the code attached to Map1's OnMouseDown procedure.
procedure TForm1.Map1MouseDown(Sender: TObject; Button: TMouseButton;
Shift: TShiftState; X, Y: Integer);
begin
if (ZoomBtn.Down) then
Map1.Extent := Map1.TrackRectangle;
if (PanBtn.Down) then
Map1.Pan;
end;

Selecting the first button in the toolbar sets the mouse to be a zoom tool; otherwise, if you click
the map, you can use the mouse to pan.

Im plem ent the Fu llExtent Bu tton
In this section you will re-implement the Full Extent button that you deleted.
1.
2.

Select the FullExtentBtn on the form and double-click the OnClick event in the Property
Inspector Events page to create an event handler and open it in the code window.
Add code to the FullExtentBtnClick event.
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procedure TForm1.FullExtentBtnClick(Sender: TObject);
begin
Map1.Extent := Map1.FullExtent;
end;

The FullExtentBtnClick event is generated whenever the FullExtentBtn is clicked.

Tes t You r Cha ng es
1.
2.
3.
4.

Click the Run button in the Delphi toolbar.
Click somewhere on the map to zoom into a rectangle.
Click the pan button in your application's toolbar.
Click somewhere on the map and drag to pan.

5.

Click on the full extent button (the globe) in your application's toolbar to draw the map at its
full extent.

Sa ve you r cha ng es
1.
2.

Close the form to return to design mode.
Click the Save All button in the Delphi toolbar to save your changes.

Crea ting a Find Tool
In this section you will add additional controls to your application to implement a simple
function for locating a state by name.
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Add Controls to the Form
Like the toolbar panel at the top of the form, adding another panel at the bottom of the form will
make it easier to handle form resizing and automatic positioning of the controls.
1.

Click the Panel control on the Standard palette then click the bottom of the form to add a
panel.

2.

Set the Caption property of the panel to blank, the Align property to alBottom and the
BevelOuter property to bvNone.
With the panel selected, click the Label control on the Standard page of the component
palette and click the panel to add a text label control.

3.
4.
5.

Set the Caption property of the text label control to “State:.”
With the panel selected, click the Edit control on the Standard page of the component palette
and click the panel to add an edit control.

6.
7.

Set the Text property of the edit control to blank.
Select the label and edit controls.

8.
9.

Select the Alignment Palette item from the View menu to display the Alignment Palette.
Click the align vertical centers button, then center vertically in window button to position
the new controls.

Edit the u s es s ectionof the code
Add a ComObj entry to the Uses clause for the form (at the top of the .pas file).
uses
Windows, Messages, SysUtils, Classes, Graphics, Controls, Forms,
Dialogs, OleCtrls, MapObjects_TLB, StdCtrls, ExtCtrls, Buttons,
ComObj;
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Atta ch Code to the TextBox
1.

Select the edit control, Edit1.

2.

In the Object Inspector, select the Events page and double-click the OnKeyPress event to
create an event handler and open the code window.
Add code to the KeyPress procedure.

4.

Procedure TForm1.Edit1KeyPress(sender: TObject: var Key: Char);
var
lys
: IMoLayers;
layer
: IMoMapLayer;
recs
: IMoRecordset;
shp
: IMoPolygon;
rect
: IMoRectangle;
fields : IMoFields;
exp
: string;
begin
// check for the enter key
if (Key = #13) then
begin
// build a search expression
exp :='STATE_NAME =''' + Edit1.Text + '''';
lys := Map1.Layers;
layer := IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
layer := IMoMapLayer(lys.Item('STATES'));
// perform the search on the STATES layer
recs := layer.SearchExpression(exp);
// show the results, if any
if (not recs.EOF) then
begin
fields := recs.Fields;
shp := IMoPolygon(CreateOleObject('MapObjects2.Polygon'));
// get the shape geometry
shp := IMoPolygon(IDispatch(fields.Item('Shape').Value));
// create a rectangle based on the extent of the state
rect:= IMoRectangle(CreateOleObject('MapObjects2.Rectangle'));
rect:= shp.Extent;
rect.ScaleRectangle((2.0));
// zoom to the state
Map1.Extent := rect;
Map1.Refresh;
// flash the state
Map1.FlashShape(shp, 3);
end;
// suppress a beep
Key := #0;
end;
end;

The code first builds a simple SQL query expression using the value of the Edit box’s Text
property. Then the States layer is searched using the SearchExpression method with the result
being a RecordSet object. If the value of the RecordSet's EOF property is False, the RecordSet is
positioned on the first record that satisfies the search expression. In that case, the value of the
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Shape field is obtained for the first record. The shape is flashed three times, then the Extent of
the shape is scaled and set to be the Extent of the map.

Tes t You r Cha ng es
1.
2.
3.
4.

Run your application.
Type the name of a state, for example, “Vermont,” into the Edit box. Note that the first
character must be in upper case.
Press the Enter key on your keyboard.
When you are finished running your application, close the form.

Ha ndling Res ize
When you run your application and resize the form, you'll notice that the map is not
automatically resized.

Pu t the m a p controlona pa nel
One way of resizing the map is to put the map control on a panel. Then, when the panel
automatically resizes itself the map can be resized to fit in the panel.
1.
2.

Save your project.
Select the map control.

3.
4.

Choose Cut from the Edit menu.
Add a Panel to the form by clicking the Panel control on the control palette and then clicking
the form.

5.

Set the Caption property of the panel to blank and set the Align property to alClient.

6.

Set the BevelOuter property of the panel to bvNone.

7.

With the panel selected, choose Paste from the Edit menu to place the map control on the
panel.

8.
9.

Right-click the map and choose Properties from the menu.
Ensure that the layers are still there. If they are not, delete the MapControl, add a new
MapControl, and add the layers. Ensure you reassign the MouseDown event on the Map
control.

10. Set the Top and Left properties of the map control to “0” (zero).

Res pond to the Res ize Event
1.

Select the panel added above by clicking it or by choosing it from the drop-down list in the
Object Inspector.

2.

Double click the OnResize event in the Object Inspector to add an event handler and open
the code window.
Add code to the panel’s Resize procedure.

3.

procedure TForm1.Panel2Resize(Sender: TObject);
begin
Map1.Width := Panel2.Width;
Map1.Height := Panel2.Height;
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end;

When the form is resized, the controls are resized.

Dis pla ying M a p La yers Ba s ed onSca le
In this section you will add a new layer to your map and add code which controls whether or not
that layer is visible at a given time.

Add a notherla yer
1.

Right-click the map to display the context menu. Click Properties to show the property
sheet.

2.

Click Add and locate the folder where the sample data is stored.

3.
4.
5.

Navigate to the Counties.shp file and then click Open.
Click the Counties layer in the list to select it.
Click the down arrow to move the Counties layer below the Ushigh layer.

6.

Click Properties to change the color of the Counties layer.

7.

Click OK to dismiss the Layer Properties dialog.

8.

Click OK to dismiss the property sheet.

If you run your application now you'll notice that every county in the US is displayed. At the full
extent, there is no need to display that much detail, so in response to the BeforeLayerDraw event,
you will selectively make the Counties and States layers visible or invisible depending on the
current extent of the map.

Res pond to the BeforeLa yerDra w event
1.
2.

Click the map control and double-click the OnBeforeLayerDraw event in the Object
Inspector to create an event handler and display it in the code window.
Add code to the Map1 BeforeLayerDraw procedure:
procedure TForm1.Map1BeforeLayerDraw(Sender: TObject; index:
Smallint;
hDC: Cardinal);
var
lys : IMoLayers;
ly1, ly2 : IMoMapLayer;
ext, fullExt
: IMoRectangle;
begin
lys
ly1
ly2
ly1
ly2

:=
:=
:=
:=
:=

Map1.Layers;
IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
IMoMapLayer(lys.Item(1));
IMoMapLayer(lys.Item(2));

ext
:= Map1.Extent;
fullExt := Map1.FullExtent;
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ly1.Visible := ext.Width < (fullExt.Width / 4);
ly2.Visible := ext.Width >= (fullExt.Width / 4);
end;

// counties
// states

The value of the visible property of each layer is based on the current extent of the map. If the
width of the current extent is less than or equal to one fourth of the full extent of the map, then
the counties will be visible and the states will be invisible. Because this code is executed in
response to the BeforeLayerDraw event for each layer, the value of the visible field is calculated
before drawing occurs.

Tes t you r cha ng es
1.
2.

Run your application. Notice that the Counties layer is not drawn.
Zoom into New England and the Counties layer becomes visible.

3.

Click the FullExtent button and the Counties are no longer visible.

4.

Close the form.

5.

Click the Save All button to save your changes.
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Adding a Spa tia lQ u ery Tool
In this section you'll add a new tool to the toolbar that will perform spatial queries on the map.
You'll add code to your application that will draw the results of the spatial query on the map.

M a k e the Q u ery bu ttonvis ible
1.

Select the QueryBtn.

2.

Ensure the Visible property of the QueryBtn is set to True and its GroupIndex property is
set to “1”.

Add va ria bles to the form
1.
2.

Open the Code window for the form.
In the private section of the form’s declaration, add a variable that will be the results of the
spatial query. The type of the variable is IMoRecordset.
type
TForm1 = class(TForm)
...
private
{ Private declarations }
gSelection : IMoRecordset;

Im plem ent the qu ery tool
Modify the MouseDown procedure for Map1 with the following code in bold.
procedure TForm1.Map1MouseDown(Sender: TObject; Button: TMouseButton;
Shift: TShiftState; X, Y: Integer);
var
pt
: IMoPoint;
recs
: IMoRecordset;
lys
: IMoLayers;
ly1, ly2
: IMoMapLayer;
fields : IMoFields;
field : IMoField;
const
moEdgeTouchOrAreaIntersect = 6;
begin
if (ZoomBtn.Down) then
// zoom in
Map1.Extent := Map1.TrackRectangle;
if (PanBtn.Down) then
// pan
Map1.Pan;
if (QueryBtn.Down) then
// query
begin
pt
:= Map1.ToMapPoint(x,y);
lys
:= Map1.Layers;
ly1
:= IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
ly2
:= IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
ly1
:= IMoMapLayer(lys.Item('Ushigh'));
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ly2
:= IMoMapLayer(lys.Item('Counties'));
// search for a highway within a tolerance
recs
:= ly1.SearchByDistance(pt, Map1.ToMapDistance(10),'');
fields := recs.Fields;
field := fields.Item('Shape');
if (recs.EOF) then
// nothing is found
gSelection := nil
// varNull
else
// search for counties that intersect the highways
gSelection := ly2.SearchShape(IDispatch(field.Value),
moEdgeTouchOrAreaIntersect, '');
// trigger a redraw of the MapControl
Map1.Refresh;
end;
end;

When the current tool is the spatial query tool, two searches are performed. The first search is a
point proximity search on the Ushigh layer. The point is obtained by converting the x and y
coordinates of the event, which are in control units, into map units. If the first search is
successful, the highway that is found is used as the input to the second search which is performed
on the Counties layer. The result of the second search is stored in the variable, gSelection.

Dra w the res u lts
1.
2.

Modify Map1's AfterLayerDraw procedure.
Add code to display the results of the query on top of the Counties layer.
procedure TForm1.Map1AfterLayerDraw(Sender: TObject; index:
Smallint;
canceled: WordBool; hDC: Cardinal);
var
sym : IMoSymbol;
flds : IMoFields;
fld : IMoField;
shp : IMoPolygon;
begin
if (Index = 1) then
// counties layer
begin
if (not VarIsEmpty(gSelection)) then
begin
if (not VarIsNull(gSelection)) then
begin
sym := IMoSymbol(CreateComObject(Class_Symbol));
sym.Color := clYellow;
if gSelection.EOF then
// Edit if no records are found
Exit;
flds := gSelection.Fields;
fld := flds.Item('Shape');
gSelection.MoveFirst;
while (not gSelection.EOF) do
begin
shp := IMoPolygon(IDispatch(fld.Value));
Map1.DrawShape(shp, sym);
// Release shp (needed in loops)
shp := nil;
gSelection.MoveNext;
end;
end;
end;
end;
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end;

Tes t you r cha ng es
1.
2.

Run your application and zoom into an area so that the Counties layer becomes visible.
Click the spatial query tool then click on a highway.

3.
4.

Close the form.
Click the Save Project button to save your changes.
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Sta tis tica lm a pping
In this section you will modify your application so that the Counties layer is drawn using the
underlying attribute information.

Atta ch a renderer to the Cou nties la yer
1.
1.

Select the form (Form1) in the drop-down list in the Object Inspector and double-click the
OnActivate event to display the code window.
Add code to the OnActivate procedure for the Form.

procedure TForm1.FormActivate(Sender: TObject);
var
breakVal : Double;
i
: Integer;
lys
: IMoLayers;
ly1,
ly2
: IMoMapLayer;
cbr
: IMoClassBreaksRenderer;
ddr
: IMoDotDensityRenderer;
recset1, recset2
: IMoRecordset;
stats1, stats2
: IMoStatistics;
begin
// Render
lys
:=
ly1
:=
ly1
:=

counties layer
Map1.Layers;
IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
IMoMapLayer(lys.Item('counties'));

ly1.Renderer :=
IMoClassBreaksRenderer(CreateOleObject('MapObjects2.ClassBreaksRenderer'))
;
cbr := IMoClassBreaksRenderer(ly1.Renderer);
cbr.Field := 'MOBILEHOME';
recset1 := IMoRecordset(ly1.Records);
stats1 := IMoStatistics(recset1.CalculateStatistics('MOBILEHOME'));
// calculate breaks away from the mean in both directions
// but only add those bfreaks that are within the range of values
breakVal := stats1.Mean - (stats1.StdDev * 3);
for i := 0 to 6 do
begin
if (breakVal >= stats1.Min) and (breakVal <= stats1.Max) then
begin
cbr.BreakCount := cbr.BreakCount + 1;
cbr.Break[cbr.BreakCount - 1] := breakVal;
end;
breakVal := breakVal + stats1.StdDev;
end;
cbr.RampColors(clLime, clRed);
// you will later insert code here to render the states layer
end;
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Each MapLayer object has a Renderer property A Renderer object controls how the MapLayer is
drawn. The ClassBreaksRenderer can be used to display continuous data, in this case the number
of mobile homes per capita by county.

Atta ch a renderer to the Sta tes la yer
1.

Modify the form's OnActivate procedure.

2.

Insert the following code after the RampColors method for the counties layer and before the
reserved word “end;”.
// Render states layer
ly2
:= IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
ly2
:= IMoMapLayer(lys.Item('states'));

ly2.Renderer :=
IMoDotDensityRenderer(CreateOleObject('MapObjects2.DotDensityRenderer')
);
ddr := IMoDotDensityRenderer(ly2.Renderer);
ddr.Field := 'HOUSEHOLDS';
recset2 := IMoRecordset(ly2.Records);
stats2 := IMoStatistics(recset2.CalculateStatistics('HOUSEHOLDS'));
ddr.DotValue := stats2.Max / 40;
Map1.Refresh;

Tes t you r cha ng es
1.

Run your application and look at the States layer. Notice that the polygons are now drawn
with dots that indicate the elevation.
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2.

Zoom into an area so that the Counties layer becomes visible. Notice that the counties are
now drawn in different colors, depending on the underlying attribute values.

3.
4.

Close the form.
Click the Save Project button to save your changes.
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EventTra ck ing
It is often desirable to display geographic entities on top of the map, especially if those entities
have a tendency to move. For example, a vehicle tracking system would want to display vehicles
on the map at the appropriate locations and update those locations over time without redrawing
all the layers of the map each time a vehicle changes location.
In this section you will add an event tracking layer to your application.

Add a nevent tool to you r a pplica tion's toolba r
1.

Click the AddEventBtn on the toolbar to show its properties in the Object Inspector.

2.

Ensure the Visible property is set to True and the GroupIndex property is set to “1”.

Im plem ent the event tool
1.

With the map control selected, double-click the OnMouseDown event in the Object Inspector
to display the code window.

2.

Change the MouseDown procedure for Map1 with the following code in bold:
procedure TForm1.Map1MouseDown(Sender: TObject; Button:
TMouseButton;
Shift: TShiftState; X, Y: Integer);
var
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pt
recs
lys
ly1,
ly2
fields
field
tLayer
const

begin
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: IMoPoint ;
: IMoRecordSet;
: IMoLayers ;
:
:
:
:

IMoMapLayer;
IMoFields ;
IMoField ;
IMoTrackingLayer ;

moEdgeTouchOrAreaIntersect = 6;

if (ZoomBtn.Down) then
// zoom
Map1.Extent := Map1.TrackRectangle;
if (PanBtn.Down) then
// pan
Map1.Pan;
if (QueryBtn.Down) then
// query
begin
pt
:= Map1.ToMapPoint(x,y);
lys
:= Map1.Layers;
ly1
:= IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
ly2
:= IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
ly1
:= IMoMapLayer(lys.Item('Ushigh'));
ly2
:= IMoMapLayer(lys.Item('Counties'));
// search for a highway within a tolerance
recs
:= ly1.SearchByDistance(pt, Map1.ToMapDistance(10),'');
fields := recs.Fields;
field := fields.Item('Shape');
if (recs.EOF) then
// nothing is found
gSelection := nil
// varNull
else
// search for counties that intersect the highways
gSelection := ly2.SearchShape(IDispatch(field.Value),
moEdgeTouchOrAreaIntersect, '');
// trigger a redraw of the MapControl
Map1.Refresh;
end;
if (AddEventBtn.Down) then
// add an event
begin
pt := Map1.ToMapPoint(x,y);
tLayer := Map1.TrackingLayer;
// remember to insert tLayer in var declarations
tLayer.AddEvent(pt, 0);
end;
end;

Tes t the event tool
1.

Run your application and zoom into an area
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2.
3.

Click the event tool, then click in the map to add events.
Close the form.

Add a tim er to you r form
To trigger the movement of the events, a timer control will be used.
1.
2.

Click the Timer control on the System page of the control palette.
Click the form to add a Timer control, Timer1.

3.
4.

Double-click the OnTimer event in the Object Inspector to open the code window.
Add code to the Timer procedure.

procedure TForm1.Timer1Timer(Sender: TObject);
var
maxDist
: Double;
nEventCount,
iIndex
: Integer;
geoEvnt
: IMoGeoEvent;
rect
: IMoRectangle;
tLayer
: IMoTrackingLayer;
begin
rect
:= IMoRectangle(Map1.Extent);
maxDist := rect.Width / 20;
tLayer := Map1.TrackingLayer;
nEventCount := tLayer.EventCount;
for iIndex := 0 to nEventCount - 1 do
begin
geoEvnt := IMoGeoEvent(tLayer.Event[iIndex]);
// move each event randomly
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geoEvnt.Move(maxDist * (Random - 0.5), maxDist * (Random - 0.5));
geoEvnt := nil;
end;
end;

Add a Check Box to you r form
To control the timer, a CheckBox control will be used.
1.

Select Timer1 control and set its Enabled property to False.

2.

Add a CheckBox control from the Standard controls page to the bottom of the form.

3.

Set the Caption property of the check box to “Data Collection”.

4.

In the Object Inspector, double-click the OnClick event for the check box to open the code
window.
Add code to CheckBox1's Click procedure.

5.

procedure TForm1.CheckBox1Click(Sender: TObject);
begin
Timer1.Enabled := CheckBox1.Checked ;
end;

Tes t you r cha ng es
1.
2.
3.
4.
5.

Run your application.
Zoom into an area.
Click the event tool, then click in the map to add events.
Click the Data collection check box. The events start moving randomly on top of the map.
Click the check box again to stop the events.

W ork ing w ith Da ta Connectionobjects
In each of the previous sections you have worked with MapLayer objects that were specified
interactively using the Map control's property sheet. In this section you will add code to your
application which creates MapLayer objects programmatically using a DataConnection object.

Rem ove the exis ting la yers
1.

Right-click the mouse on the map to display the context menu.

2.

Choose Properties to display the property sheet.

3.

Click on the Ushigh layer, then click Remove to delete the layer.

4.

Remove Counties and States in the same manner, then click OK.

Add a procedu re w hich w illinitia lize the m a p
1.
2.

Open the Code window.
In the form’s private declaration section, declare a procedure.
{ Private declarations }
gSelection: _Recordset ;
procedure InitializeMap ;

3.

Add the procedure to the end of the code.
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procedure TForm1.InitializeMap;
var
dc
: IMoDataConnection;
layer : IMoMapLayer;
sym
: IMoSymbol;
lys
: IMoLayers;
begin
dc :=
MoDataConnection(CreateOleObject('MapObjects2.DataConnection'));
dc.Database := 'c:\Program Files\ESRI\MapObjects2\Samples\Data\Usa' ;
if (dc.Connect) then
begin
layer := IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
layer.GeoDataset := IMoGeoDataset(dc.FindGeoDataset('States'));
sym := layer.Symbol;
sym.Color := clYellow;
lys := Map1.Layers;
lys.Add(layer);
layer := IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
layer.GeoDataset := dc.FindGeoDataset('Counties');
lys := Map1.Layers;
lys.Add(layer);
layer := IMoMapLayer(CreateOleObject('MapObjects2.MapLayer'));
layer.GeoDataset := dc.FindGeoDataset('ushigh');
// sym.Color := clRed;
lys.Add(layer);
end
else
raise Exception.Create('The data could not be located.');
end;

3.

Add a call (see bold below) to your procedure in the Form's OnActivate procedure.
procedure TForm1.FormActivate(Sender: TObject);
var
breakVal : Double;
i
: Integer;
lys
: IMoLayers;
ly1,
ly2
: IMoMapLayer;
cbr
: IMoClassBreaksRenderer;
ddr
: IMoDotDensityRenderer;
recset1,
recset2
: IMoRecordset;
stats1,
stats2
: IMoStatistics;
begin
// Initialize the map
InitializeMap ;
// counties layer

… … … … ..
4.
5.

Run your application to test the changes.
Save your changes.

